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1.0 Contact Info

If you have questions regarding your task as outlined in this
booklet, contact Ms Jaime Huther in the first instance.

Ms Jaime Huther

Research Project Coordinator for Prof. William F. Laurance
Centre for Tropical Environmental & Sustainability Science
James Cook University

Building E2 Room 022

Phone: 4232 1427

Email: jaime.huther@jcu.edu.au

Jaime will forward your question to Dr Sloan (the author of this
manual) 1f she is unable to address 1it.

2.0 General Overview

2.1 The Goal of this Exercise

The presence of roadways is one of the clearest and most significant
indicators of human’s occupation and perturbation of the natural
environment. Road infrastructure is poised to expand greatly
globally, particularly in the tropics, as populations, incomes and
economic ambitions continue to expand. Knowing the extent and
nature of current roadways will help decision makers prioritise
where new roads should and should not be situated in order to
balance economic development with ecological conservation.

The research project to which you will contribute as a citizen
scientist seeks to define this balance. As a first step, the
project will, with your assistance, develop a spatial database of
existing roads across insular Southeast Asia, including those roads
not officially mapped or recognised by national governments. In
this way, researchers at James Cook University will be able to
assess the current extent of roads amongst remaining ecologically-
intact areas and indicate where proposed road infrastructure should
and should not be situated.

2.2 The Basics of your Task

Using free Google Earth software to view satellite imagery of
insular Southeast Asia (Indonesia, Malaysia, Papua New Guinea,
Brunei), you are charged with two tasks:

(1) Visually identifying and manually mapping ‘new roads’ not
already mapped by official-road maps, and



(ii) Classifying these ‘new roads’ according to whether they
are paved or unpaved as well as the date of observation.

The following pages will detail the step-by-step instructions
necessary to achieve these goals. Rest assured, these are simple
and straightforward. Due diligence and care are however of the
utmost importance to ensuring an accurate and useful final map of
roadways in the region.

Note: These instructions are intended for users of Windows
computers. If you have an Apple/Mac computer, contact Ms Huther
before proceeding.

There are Windows computers available for use in a computer
laboratory at James Cook University, namely Room 014 of Building
El, available from November 28 to December 23 of 2016 and from
January 2 to Friday 10 of 2017. You must have a valid JCU
student identification card to gain access to the computer
laboratory.

If you have been tasked instead with inspecting official roads and
classifying them according to their paved status, refer to the
orientation booklet Classifying Official Roads in Insular Southeast
Asia Using Google Earth.

2.3 Terminology Used In this Booklet

Official Roads: Refers to those roads already mapped by a national
government, i.e., the government of Indonesia. Our ultimate goal is
to add to these official roads by looking for and mapping unmapped
‘new roads’ in Google Earth.

New Roads: Refers to those roads you visually identify and manually
map using Google Earth and which are not part of an official road
dataset. The roads are not ‘new’ in the sense that they have been
recently constructed, though some may have been. Rather, they are
‘new’ in the sense that they are not part of the official road
dataset and so are instead newly discovered by us through visual
analysis of Google Earth satellite imagery.

Attribute Data: Refers to the basic attributes or characteristics of
the new roads we map. When we visually identify, interpret and map
a new road we will also label the new road with its corresponding
attributes, thus creating attribute data. The specific attributes
of interest for us are as follows:

e road paved status (i.e., paved or unpaved), and

e observation date of the road (i.e., the acquisition date of
the satellite imagery in Google Earth in which the new road is
observed) .



Google Earth File: Refers to computer files with a file extensions
of “.kmz” or, sometimes, “,kml”. These files are map files that
Google Earth uses, and which you can edit within Google Earth.

2.4 Google Earth and Your Digital Materials

Google Earth is a free software that allows users to view satellite
imagery of any region of the Earth. We will use it to identify and
map new roads alongside official roads, which you will also view in
Google Earth. You can freely download Google Earth and install it
on your computer at this link:

https://www.google.com/earth/download/ge/agree.html

An internet connection is required to perform the tasks outlined in
this booklet.

As detailed in later sections, you should already have the following
Google Earth map files, which are required to get started mapping
new roads. Contact Dr Sloan if you do not have these.

e A few maps of official roads, specific to your assigned region
in insular Southeast Asia. These files have numerical file
names like ‘25k 123.kml’, ‘50k 456.kml’, or 250k 789.kml’

e One map of a ‘fishnet’ graticule with individually numbered
grid cells of ~10x10 km, probably called Grid SEA.kml,
specific to your assigned region in insular Southeast Asia.

3.0 Detailed Overview

3.1 Maximising Your Computer Resources

The official-road maps we will view in Google Earth can be taxing
for your computer. To help your computer handle them, begin by
instructing your computer to operate in ‘high performance’ mode, as
seen in Figure 1.
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Figure 1: Power Options on your Computer

Find this option on your computer either by either (a) right
clicking the battery symbol on the lower-right of your screen
(Figure 2) or by (b) going into Control Panel > Hardware and Sound >
Power Options.

[# Dell Extended Battery Life Options
k4 Dell Power Manager Lite

Adjust screen brightness
Power Options
Windows Mobility Center

(7= E ENG
3/11/2016 ~

Figure 2: Power Options on Your Computer

Also, close any other programs your computer is running (e.g.,
Skype) so that it is not unnecessarily diverting resources to them.

3.2 Getting to Know Your Official-Road Map

You will begin with various maps of official roads for the region of
insular Southeast Asia in which you’ll be working. Your specific
region will be clear to you at the outset of your work, as it will
be delineated in Google Earth by your map of ‘grid cells’ (see
Section 3.3 for details on your map of grid cell).

The official-road maps with which you’ll begin your mapping of new
roads will capture most, but not all, of the roads visible in Google
Earth. Roads that are visible but unmapped are of interest to us -
these are the ‘new roads’ we wish to map. These new roads will



occur amongst the official roads as well as in the peripheries of
areas containing official roads.

The official-road maps you have will are Google Earth map files. In
this booklet, the Google Earth map file of official roads I will use
as an example is called ‘JALANLN 50K’ (Jalan means ‘road’ in
Indonesian). Your official-road maps will not have this name,
however. Rather, your Google Earth map files of official roads will
have various names that appear much like those below.

e 25k 123.kmz
e 50k 456.kmz
e 250k 789.kmz

In Section 3.2.3 I explain the reason behind this particular file

name convention for your Google Earth map files of official roads.
You can still read through Section 3.2.1 and 3.2.2 without knowing
this reason.

3.2.1 Basic Contents of a Google Earth File (of Official Roads)

Let’s look at an official-road map in Google Earth to get
orientated. Open Google Earth on your computer, then in Google
FEarth add to your display a single Google Earth map file of official
roads, e.g., ‘50k 123.kmz’, or whatever your file happens to be
called. Do so by going to File > Open and then selecting any single
Google Earth map file of official roads. Google Earth should
automatically zoom to the extent of your official-road map, as in
Figure 3 below.
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Figure 3: Initial View of Official-road map in Google Earth



Hint: Later, if necessary, you can open more than one official-road
map at once. This will be necessary in two situations:

(1) For a single location, you must simultaneously display two
official-road maps of different scales (recall Section
3.2.3, and consult Section 5.1.2).

(11) The local area (i.e., ‘grid cell’ as per Section 3.3) in
which you are mapping new roads spans the edges of two
adjacent official-road maps.

It is recommended that you do not add more than one official-road
map to your display unless necessary, because these files are taxing
on your computer’s resources and may slow down your navigation
within Google Earth.

Your computer should now look like Figure 3 above. However, your
official-road map will have a different file name, be for a
different location, and it will likely be a different colour to
Figure 3. ©Note the following points of interest in Figure 3, which
also apply to your display.

e The Google Earth map of official roads, here called
JALANLN 50K, is indicated by a globe symbol on the left-hand
panel of Google Earth. 1In Figure 3 above it is highlighted in
blue.

e In the left-hand panel in Google Earth, the file JALANLN 50K
is visible under the heading ‘Temporary Places’. All files
listed under the heading Temporary Places are Google Earth
files that you have saved in specific directories on your
computer, e.g., C:\My Documents\My Official Road
Maps\JALANLN 50K.kmz. This is exactly how we want it. Never
save any of your Google Earth files in your ‘My Places’
directory in Google Earth, which is also visible in the left-

hand panel in Figure 3. Doing so would transfer your Google
Earth map file to some hard-to-find directory on your
computer.

In the left-hand panel, to the very left of your map of official
roads (‘JALANLN 50K’ here), you will see plus symbol, as below:

= B = JALANLN 50K

Click on the plus symbol to expand the map file of official roads
(JALANLN 50K). The plus symbol has now turned into a minus symbol
(“-%), and you should now see a little folder or ‘sub-directory’ of
the same name as your official map of official roads (JALANLN 50K
here), as highlighted in Figure 4 below.
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Figure 4: Expanded View of Official-road map JALANLN_50K.

The sub-directory JALANLN 50K also has a plus symbol to its left, as
in Figure 4. Click on this plus symbol to expand the sub-directory
and see its contents. The plus symbol has again now turned into a
minus symbol as your view becomes like in Figure 5.
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Figure 5: Fully Expanded View of the Google Earth File of an Official-road map, JALANLN_50K.

Each of the little elements in Figure 5, here titled “[no name}”,
are individual roads in the Google Earth map file of official roads,
JALANLN 50K. 1In the language of Google Earth these elements are
‘ways’, i.e., individual linear features in the Google Earth file.
On your computer, these elements might occasionally be labelled
“NULL” or similar, but their particular name does not matter for us.

There are lots of ‘ways’ - often too many to scroll through. If you
double-click on an individual ‘way’ in the left-hand panel of Google
Earth you will automatically zoom to the corresponding individual
road. Even after zooming to that road it may be hard to identify it
amongst the many other roads surrounding it. It is some help to
know that a given individual road in question will be situated in



the centre of your screen and will be defined as a single length
spanning the two nearest intersections of roads.

Technical Tip: If your computer takes a long time to zoom to
the road you double-clicked on and/or takes a long time to
refresh the display after zooming, you might find it helpful to
increase the speed with which Google Earth zooms and pans. Do
this by going to menu Tools > Options. In the dialogue box that
appears, click the ‘Navigation’ tab and increase the ‘Fly-To-
Speed’ setting as in the picture below.

= Google Earth Options ? X
3D View | Cache \ Touring Navigation General |
Fly-To
Fly-To Speed: [4.4360 Slow | Fast

Mouse Wheel

Fast

£

Speed: Slow

[ Invert mouse wheel zoom direction

Non-mouse Controller Navigation
[~ Enable Controller Do not automatically tilt while zooming
- © Automatically tilt while zooming
Regerse Gantrols " Automatically tilt and enter ground level view
[~ Enable Visualization " Gradually slow the Earth when rotating or zooming

Restore Defaults oK Cancel Apply

At this point, in the left-hand panel of Google Earth, click on the
minus symbol next to the sub-directory (folder) JALANLN 50K to
collapse it so that your view is like Figure 4 again. Similarly
click the minus symbol next to the Google Earth file JALANLN 50K to
collapse it so that your view is again like in Figure 3.

3.2.2 Changing the View of a Road Map

Before going too far, let’s change the colour of your official-road
map to ensure that its roads are readily visible in Google Earth.
The following steps are also applicable to the map of new roads that
you will eventually create.

It is essential that your maps of official roads display roads in
different colours to the new roads you will eventually map. This
will help you keep track of where you have already mapped new roads,
so that you don’t repeat your efforts. Note that changes to the
colour of your road maps in Google Earth might be temporary, so you
may have to repeat these steps each time you add a Google Earth map
file of official or new roads to your display in Google Earth.

10



With your view in Google Earth looking like Figure 3, right click on
your map file of official roads (JALANLN 50K here) in the left-hand
panel. In the pop-up menu that appears, select ‘Properties’. A
dialogue box with wvarious tabs should appear in Google Earth. 1In
the dialogue box, click the tab “Style, Colour”, as in Figure 6
below. In this box, you can adjust the colour, width, and opacity
of the official roads in your map file, JALANLN 50K. I recommend
the settings show in in Figure 6.

Google Earth - Edit Folder H

Name: [JALANLN_50K

" Allow this folder to be expanded
[~ Show contents as options (radio button selection)

Description Style, Color | View ] Altitude ]

Lines
Color: [ ] Width: [1.0 =] Opacity: [100% =

Balloon

Text:

OK Cancel J

Figure 6: Style and Colour Tab in the Properties Dialogue Box for JALANLN_50K Official-road map

Before clicking ‘ok’ in the dialogue box, click on its ‘Altitude’
tab. Confirm that the option for altitude in this tab is set to
‘clamped to ground’, as shown in Figure 7 below. If this option is
not as in Figure 7, change it so that it is. ©Now click ‘ok’ to
close the Properties dialogue box.

Google Earth - Edit Folder n

Name: [JALANLN_50K

¥ Allow this folder to be expanded
[~ Show contents as options (radio button selection)

Description | Style, Color | View  Altitude |

Altitude: ]Om JEIamped to ground j

Ground _J— Space

[~ Extend path to ground

OK Cancel J

Figure 7: Altitude Tab in the Properties Dialogue Box for JALANLN_50K Official-road map.
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3.2.3 Naming Convention for Map Files of Official Roads

As mentioned above, your Google Earth map files of official roads
will have names that appear much like those below.

e 25k 123.kmz
e 50k 456.kmz
e 250k 789.kmz

Your map files of official roads will always begin with one of the
three prefixes ‘25k’, ‘50k’ or ‘250k’.

To avoid confusion, it is important that you understand the meaning
of the file names of your Google Earth map files of official roads.
In short, the file name for any given Google Earth map file of
official roads contains two bits of information about the official-
road map in question:

1. The geographic scale of a given Google Earth map file of
official roads is indicated by the prefixes of the file names
(e.g., '25k’, '50k’ or 250k’ in the examples above). In non-
technical terms, the geographic scale of a map indicates the
level of detail one can expect in that map. For our maps of
official roads, the prefix ‘25k’ indicates a fine scale of
1:25,000 (i.e., high level of detail), the prefix ‘50k’
indicates an intermediate scale of 1:50,000 (i.e., moderate
level of details), and the prefix ‘250k’ indicates a coarse
scale of 1:250,000 (i.e., low level of detail). Thus, files
with the prefix ‘25k’ will generally have more and more
accurately mapped roads than files with the prefix ‘50k’,
which in turn will generally have more and more accurately
mapped roads than files with the prefix ‘250k’.

2. The location within insular Southeast Asia of a given Google
Earth map of official roads is indicated by the suffix of the
file name (e.g., ‘123", '456’, ‘789’ in the examples above).
The actual numerical references do not concern us. Suffice to
note here that, in simple terms, each number denotes a
different location from the next. The suffixes in your actual
Google Earth map files of official roads will have anywhere
from one to three numerical digits and range between 1 to 689.

There is one good reason why you need to understand this file name
convention: you will have many Google Earth map files of official
roads, and in some instances these map files will be defined at
different geographic scales for the same locations. For example,
you may have one Google Earth map file of official roads named ‘25k
417.kml’ and another called ‘50k 417.kml’. From the preceding
discussion, you will now understand that such files are for the same
location (denoted by the suffix, ‘417’) but at different scales
(denoted by the prefixes ‘25k’ and ‘50k’). It is important to
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recognise this so that you do not repeat your efforts by consulting
the same location twice. Section 5.1.1 makes use of the preceding
information when instructing you on the specifics of mapping new
roads in Google Earth.

3.3 Getting to Know Your Grid-Cell Map

You have been assigned to search for new roads in a specific region
of insular Southeast Asia. Your specific region is delineated by
your single Google Earth map file of ‘grid cells’, which is called
Grid SEA.kml. This map file displays a few hundred contiguous grid
cells, which are ‘squares’ of approximately 10 km by 10 km each.

The grid cells will help you keep track of where you have already
mapped new roads within your region so you do not repeat your
efforts. You are tasked with mapping new roads only within the grid
cells of your map file, Grid SEA.kml.

3.3.1 Changing the View of Your Grid-Cell Map

When you first open your grid-cell map in Google Earth (File >
Open), it will look similar to Figure 8. However, your Google Earth
map file of grid cells will probably be for a different region of
insular Southeast Asia. Your grid cells will also be of a different
colour, and they might even be transparent (just outlined), which is
fine.

Figure 8 displays only the grid-cell map in the left-hand panel. 1In
reality, while you are mapping new roads you will have both the
grid-cell map and one or more official-road map(s) loaded in Google
Earth at once.

As done previously for our official-road map, expand the grid-cell
map ‘Grid SEA’ in the left-hand panel in Google Earth to see its
sub-directory, which is also called Grid SEA. Then expand that sub-
directory to see all the individual elements inside it, as per
Figure 9.

13
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Figure 8: Grid-cell map for a Given Region within insular Southeast Asia
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Figure 9: Expanded View of the Contents of the Grid-cell map

As with the individual roads of the official-road map (Figure 4),
each element of the grid-cell map (i.e., the numbered green boxes in
Figure 9) is an individual grid cell of approximately 10x10 km. The
blue numerical labels you see in Figure 9 (labelled ‘1’ through '6’)
are the unique identifying numbers of the cells. There are 34,414
cells in total spanning all insular Southeast Asia. Your region
probably has a few hundred cells at least. Figure 9 just shows the
first 6 cells. The unique identifying numbers of your grid cells
will be different to those in Figure 9, of course.

Note: These unique identifying numbers of the grid cells have no
relationship whatsoever with the unique identifying numbers or
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‘file name suffixes’ denoting the location of a given official-
road map (Section 3.2.3).

With your view of the grid-cell map’s contents expanded as per
Figure 9, double click on any one of its elements (blue numbered
grid cells) in the left-hand panel. Google Earth should immediately

zoom to that cell. I double clicked cell number 5 and zoomed to it,
as shown in Figure 10.
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Figure 10: Initial View of a Single Grid Cell

There are two things to note in Figure 10:

(1) The pop-up bubble in the center of the grid cell
confirms that you’re looking at cell 5 (Remember: your
cells will have different identifying numbers).

(2) The cell in Figure 10 is opaque, so you cannot see any
satellite imagery or roads within the grid cell. (If
your cells are instead transparent with solid outlines
like in Figure 11, then that’s fine too. The
remainder of Section 3.3.1 is still important).

To fix this opacity problem we must change the view of the grid-cell
map, much as we did for the map of official roads, so we can see the
roads that occur within the grid cell. Steps to do so are detailed
below and partly shown in Figure 11.

e In the left-hand panel of Google Earth, right-click the grid-
cell map ‘Grid SEA’ (not the sub-directory of the same name),
and in the resultant pop-up menu select ‘Properties’.

e TIn the dialogue box that appears, click the ‘Style, Colour’
tab.
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e For the ‘Lines’ colour, select a bright colour that is not the
same as your road map. These will be for the lines (edges) of

the grid cells. For the ‘Area’ colour, select ‘Outlined’ in
the adjacent drop-down menu (Figure 11). This tells Google
Earth that there is no fill colour (just outlines) for the
grid cells.

[ Search

Get Directions History Google Earth - Edit Folder

;J Name: [Grid_SEAl
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[ Show contents as options (radio button selection)
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Image Landsat
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% Image ©2016 DigitalGlobe Google Earth
QIE (][ T SR R~ [ R T T

» 1 avere Earth Gallery » Tour Guide 2003 Imagery Date: 12/14/2015 11°21'18.00" S 153°24'18.00" E elev -71 m eye alt 14.20 km

Figure 11: Adjusted View of a Single Grid Cell

Your grid-cell map should now look like that in Figure 11. Note
that while we can see the edges or outline of the grid cells, their
areas are now fully transparent.

3.3.2 Using your Grid-Cell Map to Efficiently Map New Roads (UPDATED!)

You are responsible for mapping new roads throughout all grid cells
defined by your Google Earth map file of grid cells. When mapping
new roads you’ll want to inspect your grid cells one by one and
individually ‘tick off’ each cell you inspect. This is very
important, both for you to avoid revisiting cells later and for the
larger JCU research project to keep track of which cells have been
mapped. The method to tick off cells is outlined below.

Hypothetically, let us suppose that you are assigned only three grid
cells: numbered 5, 6 and 7. To begin your mapping, let’s start with
grid cell 5. In the left-hand panel in Google Earth, double click
on the element for cell number 5 (or whichever is your first grid
cell in your file) to zoom to that grid cell, as in Figure 12a.

16



As in Figure 12a, your ‘cell 5’ should still be transparent after
having followed the steps above. After inspecting grid cell 5 and
mapping all its roads, we will change both the colour and the label
of cell 5 to indicate that we have finished mapping all its roads.

To do so, in the left-hand panel of Google Earth, right click the
element for grid cell 5 (or whichever is your first cell) and select
‘Properties’ in the resultant pop-up menu, then..

e _.In the ‘Description’ tab of this ‘Properties’ dialogue box,
write “done” in front of the original cell number/label (5’
in this case), as shown below, and then..

Google Earth - Edit Placemark

Mame: |done 5

Description ] Style, Color 1 Wiew ] Altitude |

e _In the ‘Style, Colour’ tab of this same ‘Properties’ dialogue
box, adjust the ‘Colour’ parameter from ‘Filled’ to ‘Filled +
Outlined’, selecting whichever solid ‘fill colour’ you wish,
as in Figure 12b. Now click ‘ok’, and your ‘cell 5’ will look
a lot like mine in Figure 12b.

This method or re-labelling and re-colouring must be strictly
adhered because later stages of the JCU project depend on it.

Now your ‘grid cell 5’ should be completely opaque again and have a
new label in the left-hand panel (Figure 12b), while your remaining
cells are still transparent. At this point we can double click on
the element for the next cell in the left-hand panel (being number 6
in this example), automatically zoom to its location, map new roads
there, re-colour and re-label that cell as described above, then
move on to do the same in the next cell (number 7 in this example),
and so on.

17



= Google Earth
File Edit View Tools Add Help
¥ Search

ctions History

¥ Places

= M1 My Places
 P]ED Sightsesing Tour

Make

G

3D Buildings
ked

= &= Temporary Places

=@

= Grid_SEA

4

S
g

[ 10 1o 1~ 191 I s 1

HEE

=
R R A R I R SRS S

=

Bl R

=

I3 83 I 1

=

s s
Q@ |«|+

b Layers Earth Gallery »

Google Earth

-71m  eyealt 1510 km O

= Goog
File Edit View Tools Add Help
¥ Search

Get Directions History

¥ Places

El M1 My Places =]

# B2 Sightseeing Tour
Mak

Name: [done 5

Description

Style, Color | view | Altitude |

HEE
[P

=

Area

Lines.
coor: [ width: [o4 = opacty: [100% =]

color: [ | [Filed+outined | opacty: [100%

=3

SR S R O N O

;‘\E\H\EIBIEIEH\a‘\d\ﬁ\d\ﬁlilé""m“"‘m}:
7

INEHENEEEEENREREEEEEEE

F A &

Figure 12b: Grid Cell 5 Now ‘Ticked Off’

3.4 Saving Your Altered Grid-Cell Map
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This section concerns saving changes to your grid-cell map,

Grid SEA.kmz.

Saving changes to the Google Earth map file of new
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roads that you will create entails a slightly different protocol,
described in Section 5.2.

Within a given session of Google Earth, change you make to a Google
Earth map file are temporary. These changes include: (a)adjustments
to the colours/opacity of grid cells, (b) changes to the names of
individual grid cells, and (c) the mapping (addition) of new roads
(Section 5.1.3). To save such changes to your Google Earth map
files you must save your map files before closing Google Earth.
Strangely, in Google Earth the way to save changes to a Google Earth
map file is to save a new version of the map file! In the case of
our altered grid-cell map Grid SEA, we do so as follows:

e In the left-hand panel, right click the Grid SEA Google Earth
map file (not its sub-directory of the same name). 1In the
pop-up menu that appears, select ‘Save Places As’, as per
Figure 13 below. DO NOT become confused and select the option
‘Save to My Places’.

e A dialogue box appears, asking you to specify the new file
name and a directory location for the altered version of the
grid-cell map Grid SEA you are saving.

o Helpful Hint: I recommend saving the altered file with
the same name as the original plus the date on which you
save the file, e.g., Grid SEA Nov28.kmz, presuming you
altered the file on November 28. This way, after many
sessions in Google Earth in which you create many
versions of a given map file, you will still easily know
which version of your map file is the most recent. I
recommend keeping older version alongside newer versions
in a single directory (e.g., ‘C:\My Documents\My Grid
Maps\’). This way, should you discover that your current
version of a map file is rubbish, you still have the
option of discarding it and re-commencing your work from
an earlier version of the file.

In your subsequent mapping session in Google Earth, you can continue
your work by opening the most recent version of your Google Earth
map file of grid cells (e.g., Grid SEA Nov28.kmz) and new roads
(discussed 1in later sections).

It’s also a very good idea to save your work as above during a
Google Earth session, especially if your computer is prone to
freezing or crashing. You will lose all your unsaved work if (or
rather, when) Google Earth crashes!!!
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Figure 13: Saving an Altered Google Earth File to a New File

When you close Google Earth, you’ll see the dialogue box below. If
all your changes to your Google Earth files are already saved to a
new version of the file (e.g., Grid SEA Nov28.kmz), click ‘Discard’.
If not, click ‘Cancel’ and save new versions of the files. Never
click ‘Save’ in the dialogue box below. (If you do, your files will
be saved, but they’ll be transferred to your My Places’ directory
deep in your C drive controlled by Google Earth, making them harder
to find and update later).

=~ Google Earth X

Ie You have unsaved items in your “Temporary
J Places” folder. Would you like to save them to
your "My Places” folder?

Save Discard Cancel

5.0 Mapping New Roads

5.1 How to Map New Roads and Assign Them Attribute Data

In Google Earth, your display should now have both a transparent
grid-cell map (Section 3.3.1) and at least one official-road map.
This section discusses how to use these files to search for new
roads, how to map the new roads in Google Earth, and how to assign
attribute data to these new roads.

20



5.1.1 How to Search for New Roads Within Your Grid Cells

Using your map(s) of official roads as a reference of where roads
already exist, visually search for new roads in Google Earth on a
cell-by-cell basis. Zoom to an individual grid cell and visually
scan its area for new roads in a systematic manner. For example,
scan from left to right and from top to bottom. This way you are
most likely to visually identify all new roads in your grid cell
with the least investment of time and without overlooking areas
within your grid cell. Once you have fully scanned the grid cell
and mapped any new roads it contains, do not forget to make that
grid cell opaque to remind yourself that you have finished working
within it.

5.1.2 Protocols for Mapping New Roads (Important)

There are a few basic protocols applicable to the search for and
mapping of new roads, listed below. These are essential to ensuring
a minimum standard of scientific reliability, and so must be adhered
to at all times.

e You must not attempt to visually identify (and certainly not
map!) roads while viewing the Earth at altitudes greater than
5 km. In non-technical terms, the altitude of observation is
your ‘zoom level’ in Google Earth. While visually scanning
your grid cell, you are encouraged to ‘zoom in’ using Google
Earth as close as necessary in order to identify and map the
new roads (Section 5.1.3). In Figure 14, you can see where
Google Earth reports your ‘visual altitude’ above the Earth
(4.88 km in the figure) as well as the buttons by which you
can increase or decrease your altitude / zoom. In practice
you will generally view the Earth at altitudes ranging from 1-
4 km.

e Recalling the meaning of the ‘prefixes’ (i.e., scales) and
‘suffixes’ (i.e., locations) of the names of your Google Earth
map files of official roads (Section 3.2.3), where two map
files of official road exist at different scales but for the
same location you should display both map files simultaneously
in Google Earth while searching for new roads. For example,
if I have the official-road maps ‘250k 612.kmz’ and ‘50k
612.kmz’, these are clearly both for the location, denoted
‘612", so I should display both these official-road maps
simultaneously in Google Earth while scanning for new roads in
the location covered by these two maps. The simultaneous
observation of both maps of official roads is important
because the official-road maps of different scales are
generally incomplete in different ways, so that only together
do they present a complete picture of the extent official
roads.
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o When simultaneously displaying two maps of official road
with different scales for the same locations, it is a
good idea to colour the coarser-scale map with a thicker,
darker lines than the finer-scale map (see Section 3.2.2
for map colouring). When viewing both maps of official
roads at once for a given location, you’ll note that they
do not align perfectly with each other. This is due to

their difference in scale. Generally, the coarser-scale
map will be less accurate than the finer-scale map. That
is ok.

o Maps of official road of different scales for the same
locations occur only in a few areas of insular Southeast
Asia:

" Sumatra - maps of official roads at the scale of
*250k’” coincide with maps of the scale ‘50k’ across
the entire island of Sumatra. (Google ‘Sumatra’ if
you do not know where it is). So, for those of you
mapping new roads anywhere in Sumatra, ensure that
you are displaying both your official-road maps at
250k and 50k scales for any given location.

= Eastern Papua - maps of official roads at the scale
of '250k’ coincide with maps of the scale ‘50k’ in
Eastern Papua for all Google Earth map files of
official roads with the following suffixes (i.e., of
the following locations): 164, 165, 209, 210, 251,
252, 308, 309, 361, 362, 419, 420.

= Northern Papua - maps of official roads at the scale
of '25k’ coincide with maps of the scale ‘50k’ where
Google Earth map files of official roads have the
following suffix (i.e., are of the following
location): 417.

Do not search for and map new roads in towns, urban areas,
cities, and other areas characterised by concentrations of
houses, buildings, etc. (‘settlements’ hereafter). Rather,
concentrate your efforts in all other areas. Clearly, the
exact boundary between ‘settlements’ and ‘all other areas’ is
a bit of a grey area, so you are required to use your best
judgement as to what constitutes a settlement.

o The images below provide some indication of what the term
‘settlement’ refers to for our purposes. Note how 'Not
Settled’ areas may still be characterised by
concentrations of infrastructure, typically that
associated with oil-palm plantations or other
agriculture. Such areas are not primarily residential,
although sparsely distributed residences may occur within
them. Areas characterised by concentrations of
residences and associated shops etc. are considered
‘Settlements’.
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o If in doubt about what constitutes a settlement, consider
the following questions:

Are the new roads you are observing for conveying
people around their settlement? Or rather are they
for conveying people between settlements, across
rural areas, within plantations, etc.?

Are the new roads you are observing lined by houses
or buildings? Or rather are they situated in rural,
agricultural, and/or forested contexts characterised
by only occasional buildings?
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e TIf in doubt about whether a given feature visible in Google
FEarth is actually a road or some other linear feature, such as
a gully, dry river bed, etc., do not map the feature as a new
road. Similarly, 1if you suspect that a linear feature might
be a road but cannot be certain because it is overgrown with
vegetation, do not map it as a new road.

Image © 2016 DigitalGlobe
Image Landsat

Image © 2016 CNES / Astrium
Imagery Date: 2/25/2016 1°27'45.40" N 100°58'03.19" Eelev 20 m eyealt 4.88 km
Figure 14: View of Altitude and Zoom Button in Google Earth

5.1.3 How to Map New Roads in Google Earth

Visually identifying a new road in Google Earth is relatively
straightforward, and so is not discussed at length here. Basically,
you know a road when you see it. This section instead discusses the
following points:

e Road mis-interpretation
e Properly interpreting road attributes

e Mapping new roads as a Google Earth map file, and assigning
new roads their corresponding attribute data

5.1.3.1 Potential Mis-Interpretation
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The main source of road mis-interpretation arises from the
occurrence of drainage canals in peatlands. Peatlands are swampy
areas roughly distributed throughout insular Southeast Asia as per
the brown areas in Figure 15. Figure 16 shows some drainage canals
in peatlands, which apparently define the extent of a plantation.
The canals are distinguished from roads by the fact that canals are
filled with water and so are far darker than dirt roads, some of
which also visible in Figure 16 running alongside canals.

A similar but far rarer potential sources of mis-interpretation may
arise from corridors of electrical transmission wires running
between pylons (large electrical towers). These corridors often cut
long linear swaths through vegetation, and so may appear as roads.
These corridors may, in fact, occasionally be accompanied by
parallel service roads running along their lengths (as for the
electrical company), which in turn may be used by the public. 1In
such cases, you could then map the service road as a ‘new road’,
provided that it is not already captured by your official-road maps,
of course.

Figure 15: Peatlands in Insular Southeast Asia (Indonesia, Malaysia but excluding Papua New Guinea).
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5.1.3.2 Interpreting Road Attributes

As stated in Section 2.2, you are tasked with interpreting and
recording two attributes of the new roads you map:
e Road paved status (i.e., paved or unpaved), and
e Observation date of the road (i.e., the date of the satellite
imagery in Google Earth in which the new road was observed).

Observation date is the easiest attribute to identify. This
attribute is simply the acquisition date of the satellite imagery
shown in Google Earth for the area in which you visually identify a

new road. In Google Earth, this date is wvisible at the bottom of
the screen. In Figure 14, for example, the “imagery date” is
reported as “2/25/2016”, reflecting a “M DD YYYY” format for
recording the date (M = month, D = day, Y = year). We will use a

slightly DIFFERENT date format when recording the reported date as
attribute data for our new roads, namely MM DD YYYY, as detailed in
Section 5.1.3.3.

Interpreting road paved status is also straightforward. Most new
roads will be unpaved. Compared to paved roads, unpaved roads are
characterised by the relatively bright colours of bare tropical soil
and/or gravel, often with shades of orange, brown, white and grey.
Figure 16 shows an unpaved road.

Figure 17 shows both paved roads (north-sound orientation) and
unpaved roads (east-west orientation). As this figure illustrates,
often the best means of identifying a given road’s paved status is
to compare it to nearby features, including other roads, bare
patches of earth, etc.. This is particularly the case for roads
that appear to be paved, as confirming that a road is paved is often
tricky.

= Google Earth — X
Eile Edit View Tools Add Help
vSearch

s 0 = Grid SEA
=0 S JALANLN_50K

2016 DigitalGlobe

Google Earth

Imagery Date: 2/25/2016  1°33'46.35" N 100°58'39.89" E elev 24 m eyealt 342m
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Figure 17: Paved (North-South) and Unpaved (East-West) Roads in an Qil-Palm Plantation.

Other tricks for properly interpreting a road’s paved status are
listed below:

e As shown in Figure 18, paved roads will often have unpaved
edges or gullies. These stand out as bright edges against the
darker bitumen of the paved road. This ‘contextual
interpretation’ helps identify a road as paved.

e As shown in Figure 19, unpaved roads may occasionally display
tyre tracks. Care must be taken in differentiating parallel
tyre tracks from the parallel unpaved edges of paved roads in
Figure 18. Knowing your local context (e.g., plantation,
inter-settlement road) and visual altitude above the Earth
(193 m in Figure 19) will aid you in this respect.
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Figure 18: Paved Road (Northwest-Southeast Orientation) with Bare Dirt Edges.
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Figure 19: Unpaved Road with Tyre Tracks in an Oil Palm Plantation

5.1.3.3 Digitising New Roads and Assigning Them Attribute Data

Mapping or ‘digitising’ new roads simply entails using your mouse to
trace a road visible in Google Earth on your computer screen. In
doing so, you map a new road or ‘way’ that is part of a larger
Google Earth map file. Recall that we are interested in mapping
only those ‘new roads’ not already captured by the official-road
maps. The following text explains how to map new roads and assign
them their corresponding attribute data.

In preparing to map new roads during your first session of Google
Earth, it is essential that we first create a new sub-directory in
whichever Google Earth map file of official roads that you happen to
be viewing. Any Google Earth map file of official roads will
suffice. The new sub-directory you create will exclusively contain
the new roads we map through our first session of Google Earth.
Before the end of our first session we will convert this new sub-
directory of new roads into a stand-alone Google Earth map file of
new roads, which we can then build upon during later mapping
sessions.

e TIn Google Earth, in the left-hand panel, highlight (i.e.,
click on) your Google Earth file of official roads
(YJALANLN 50K’ in the example here) as shown in Figure 3 and
the graphic immediately below. Do not highlight the sub-
directory called JALANLN 50K, as in Figure 4.

~ JALANLN 50K
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e 1In Google Earth, at the top of the screen, click the ‘Add’
menu and select ‘New Folder’, as below.
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e TLabel your new folder (i.e., sub-directory) thusly: “YOUR LAST

NAME NewRoads”. 1In my example, my new folder’s name is
“Sloan NewRoads”. Your left-hand panel should now look like
mine below.
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Before digitising your first new road, ensure that your new sub-
directory (i.e., Sloan NewRoads) is still highlighted in the left-
hand panel, as shown immediately above. Highlighting this sub-
directory before digitising a new road tells Google Earth that we
want the new road ‘way’ to be saved into this particular sub-
directory and not elsewhere. This is important.

Now that we are set up to map new roads, we can do so according to
these steps:
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In the row of buttons at the top of the screen in Google
Earth, click the one labelled ‘Add Path’, which is the third
to the right of the yellow push-pin button. ‘Path’ is just
another word for ‘way’ or ‘road’, i.e. a linear feature.

! A=

O ¥oses @L & [ (Kb

A dialogue box appears in which you specify the name of your
new road. The name of your new road will contain all the
attribute data for the road, so it is important that you
understand this step well. The name of your new road will be
a composite of the following bits of information, in order,
with each bit separated by a “ ” character:
o0 Your last name
o The term ‘NewRoad’, without spaces and with both the N’
and the ‘R’ capitalised
o A ‘1’ if the road is paved, or a ‘2’ if the road is
unpaved
o The observation date, in the format MM DD YYYY.

So, in the case of an unpaved new road I identify in Google
Earth in a satellite image with an observation date reported as
“2/25/2016”, I would label this new road as

“Sloan NewRoad 2 02 25 2016”.

Similarly, in the case of a paved new road I identify in a
satellite image having the same observation date, I would label
it as “Sloan NewRoad 1 02 25 2016”".

Finally, for a paved road with a reported observation date of
12/9/2015, I would label this new road as
“Sloan NewRoad 1 12 09 2015”.

Tip: In the first example immediately above, note how the
month of observation reported by Google Earth is ‘2’ (as in
February) but it is then ‘padded’ with a leading 0 in our
attribute data so that it becomes ‘02’. This is essential
to ensuring that each and every month is denoted by two
numerical digits, from ‘01’ (January) through to ‘12’
(December). The same principle applies to days of the
month. Thus, the first day of the month is denoted '01',
not ‘1’, while the 10®* day is simply denoted as ‘10’.
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e Before clicking ‘ok’ in the dialogue box for your new road,
you must still digitise the road itself. You’ll now notice
that when you hover your mouse over Google Earth it looks like
a ‘cross hair’ symbol. As you click your mouse along the road
visible in Google Earth you can record little points or
‘nodes’ connected to each other by lines, all of which are now
visible on your screen. Continue to do this along the entire
length of the new road you are mapping. While you are in this
digitising mode you can still adjust your ‘zoom’ (altitude) as
usual. You can also pan your view up/down and left/right in
Google Earth using the four arrow keys on your keyboard. To
finish digitising your new road, double click at the end of
the road to define its ‘terminal node’. Your new road will
now be digitised, and you can click ‘ok’ in the dialogue box
to finally record the new road within your sub-directory.

e Once your new road is thus labelled and digitised, it should
appear as in Figure 20. (Your road will of course have a
different shape and colour).

e TIf you make a mistake and wish to delete a given new road
‘way’, simply right click it in the left-hand panel and select
‘delete’ in the pop-up menu. (Use the same method to remove
whole map files from your display in Google Earth. Choosing
to ‘delete’ a map file from your display will not delete the
actual file from your computer).

< Google Earth
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Figure 20: A Digitised New Road (in Teal Blue)
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5.2 How to Save Your New-Road Map in Google Earth

Upon mapping a few new roads during your first session of Google
Earth you are now ready to save your sub-directory of new roads

(“Sloan NewRoads” in Figure 20) as a stand-alone Google Earth map
file. Once saved as a new Google Earth file, can you continue to
add new roads to this map file in later sessions of Google Earth.

Saving Google Earth map files was discussed in Section 3.4. However,
the process for saving a map of new roads is slightly different, so
pay careful attention here.

Like in Section 3.4, to save your new roads right click on the sub-
directory of new roads (‘Sloan NewRoads’ in Figure 20) in the left-
hand panel and select ‘Save Places As..” in the pop-up menu. You can
now specify where on your computer you wish to save your new roads
as a stand-alone Google Earth map file. The default name of your
new Google Earth map file of new roads will be the same as your sub-
directory of new roads (Sloan NewRoads.kmz), and this should be
accepted here.

Once your Google Earth map file of new roads is successfully saved
to your computer for the first time, you must delete your sub-
directory of new roads (Sloan NewRoads) from your official-road map
(JALANLN 50K in this example). You can then add your new Google
Earth map file of new roads (Sloan NewRoads.kmz) to your display in
Google Earth (File > Open), as in Figure 21. As highlighted in
Figure 21, you’ll note that your new Google Earth map file has sub-
directory of the same name (Sloan NewRoads). That is fine.
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Figure 21: A Stand-Alone Google Earth Map File of New Roads

From this point forward, all new roads digitised anywhere in insular
Southeast Asia should be incorporated into your newly formed stand-
alone Google Earth file of new roads (Sloan NewRoads.kmz) .

Remember, when digitising new roads, the same rule discussed above
still applies: make sure that the sub-directory (Sloan NewRoads) of
your Google Earth file of new roads (Sloan NewRoads.kmz) is
highlighted as in Figure 21 before digitising new roads, in order
that Google Earth knows to record those new roads within the sub-
directory in question.

At the end of each subsequent session in Google Earth, when you wish
to save your Google Earth map file of new roads

(Sloan NewRoads.kmz), do so as described in Section 3.4: right click
the Google Earth file (not its sub-directory) and select ‘Save
Places As..”. To keep track of your files, name each version of your
Google Earth map file of new roads with the date on which you worked
on it, e.g., Sloan NewRoads Nov28.kmz, for a file worked on during
November 28.

5.3 Mapping New Roads within Grid Cells

Many new roads you observe will of course cross the boundaries of a
given grid cell. 1In this situation, there are two courses of action
you may take, depending on where the road lays:
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e Where a road crosses from one grid cell into an adjacent cell
in Grid SEA.kml, simply map the road seamlessly as it crosses
from one cell to the other.

e Where a road crosses from one grid cell into adjacent space
that is not within any of your grid cells in Grid SEA.kml,
simply map the road in question as far as the edge of your
grid cell. 1In other words, cease mapping the road once you
reach the edge of your grid cell.

5.4 Frequently Asked Questions
1. What if my official-road maps are ‘inaccurate’?

You will notice that many roads mapped by a Google Earth file of
official roads are slightly offset (typically by ~10-50 meters) from
the roads visible in Google Earth. The degree of offset will be
greatest for maps of ‘250k’ scale and least for maps of '25k’ scale.
Such offsets should NOT be interpreted as meaning that a given road
visible in Google Earth has not been captured by an official-road
dataset. Consider such roads to have been fully captured by an
official road dataset, regardless of any such offsets.

Occasionally you may also notice that your Google Earth map files of
official roads display a road occurring where Google Earth indicates
no such road exists. For example, the official-road map may display
a road through a forest that Google Earth indicates is still intact.
Overlook any such discrepancies.

2. What if I am unsure whether I am observing a road in Google
Earth?

If in doubt about whether a given feature visible in Google Earth is
actually a road or some other linear feature, such as a gully, dry
river bed, etc., do not map the feature as a new road. Similarly,
if you cannot be certain that a linear feature is a road because it
is overgrown with vegetation, do not map it as a new road.

3. What if a new road I observe is both paved and unpaved along
its length?

Map (digitise) the paved length separately from the unpaved length,
since each length will require different attribute data.
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